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SHERIFF ARPAIO RELEASES PRELIMINARY
FINDINGS ON
OBAMA BIRTH CERTIFICATE

March 1, 2012

(Phoenix, AZ) Maricopa County Sheriff Joe Arpaio in a press conference today told
reporters, “A six month long investigation conducted by my cold case posse has lead
me to believe there is probable cause to believe that President Barack Obama’s long-
form birth certificate released by the White House on April 27, 2011, is a computer-
generated forgery. I do not believe that it 1s a scan of an original 1961 paper
document, as represented by the White House when the long-form birth certificate
was made public.”

This is the principle preliminary finding of a six-month on-going Sheriff’s Cold Case
Posse law enforcement investigation into the authenticity of Obama’s birth certificate
and his eligibility to be president.

Investigators advised Sheriff Arpaio that the forgers committed two crimes: first, in
creating a fraudulent document which the White House characterized, knowingly or
unknowingly, as an officially produced governmental birth record; and second, in
fraudulently presenting that document to the residents of Maricopa County and to the
American public at large as “proof positive” of President Obama’s authentic 1961
Hawaii long-form birth certificate.

During the six-month-long investigation and after having developed probable cause to
believe the long-form birth certificate is a computer-generated forgery, investigators
began examining other evidence of President Obama’s life history including:.
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e President Obama’s Selective Service card is most likely also a forgery, revealed
by an examination of the postal date stamp on the document;

e To quell the popular idea that Obama was actually born outside the United
States, we examined the Records of Immigration and Naturalization Service
cards routinely filled out by airplane passengers arriving on international flights
that originated outside the United States in the month of August 1961. Those
records are housed at the National Archives in Washington, D.C. Interestingly,
records from the days surrounding Obama’s birth, August 1, 1961 to August 7,
1961 are missing. This is the only week in 1961 were these immigration cards
cannot be found.

When and Why Sheriff’s investigators became involved

In August 2011, 250 members of the Surprise Arizona Tea Party, residents of
Maricopa County, presented a signed petition asking Sheriff Arpaio to undertake this
investigation.

The Tea Party members petitioned under the premise that if a forged birth certificate
was utilized to obtain a position for Barack Obama on the 2012 Arizona presidential
ballot, their rights as Maricopa County voters could be compromised.

Sheriff Arpaio agreed to accept the investigation and assigned it to his “Cold Case
Posse” at no expense to the tax payers for a thorough examination. The Sheriff’s Cold
Case Posse, consisting of former law enforcement officers and lawyers with law
enforcement experienced, spoke to dozens of witness and examined hundreds of
documents, and took numerous sworn statements from witnesses around the world.

Additional findings by investigators
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Suspecting that the long form birth certificate is a computer generated forgery, they
now say they have identified persons of interest in the case.

Sheriff’s Investigator Mike Zullo says, “We have also determined during the course of
our investigation that the Hawaii Department of Health engaged in what we believe is
a systematic effort to hide any original 1961 birth records that they may have in their
possession.”

Sheriff Arpaio added, “A continuing investigation is needed to not only understand

more about the creation of the alleged birth certificate forgery, but also to determine
who, if anyone, in the White House or the state of Hawaii may have authorized it.”

The Matter of the Selective Service Registration Card

Sheriff’s Investigators were then led to investigate President’s Obama selective
service registration card allegedly filled out in Hawaii in 1980.

Investigators compared Obama’s card to others filled out in same year and to at least
two cards filled out in the same local.

The year stamp that is used on selective service registration cards should include all
four digits of the year, for example 1980, the year Obama may have registered with
selective service. However, investigators note that Obama’s registration card is highly
unusual having a year stamp including only two digits, “80” which appears to be an
inverted number. Additionally, those numbers are offset by a significant amount
suggesting that the stamp was somehow manually manipulated.

Investigators use video presentations to back up the evidence

The Cold Case Posse produced six technical videos to demonstrate why the Obama
long-form birth certificate is suspected to be a computer-generated forgery. The
videos were designed to display the testing used by the investigators to examine
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Conclusive remarks

Sheriff Arpaio stresses that these are preliminary findings and concluded by
suggesting a Congressional investigation might be warranted. Arpaio asked that any
other law enforcement agency with information referencing this investigation be
forwarded to his office.

“I want to make this perfectly clear. I am not accusing the sitting President of the
United States of committing a crime. But there remain a lot of questions which beg for
answers and we intend to move forward with this investigation in pursuit of those
answers, hopefully with the cooperation of all parties involved,” Arpaio said.
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[, Mara Zebest, am prepating this report at the request of
Maricopa County Sheriff's Office in support of the Cold Case Posse
investigation.

The PDF birth certificate document released by the White House
(shown in Figure 1) is a completely manufactured and fabricated

i R N el tesat computer generated image. The same source file was used to
E e = o‘;‘)_’: E print a copy handed to the AP (shown in Figure 2), in which the
T A B AP scanned in the version handed to them. A third photograph
3} | B [ 4

version (Figure 3) was touted by Savannah Guthrie who claimed
to have held and felt the seal on the document, but the original
Internet posted images have been scrubbed.

The White House wants us to believe the PDF document started
out in printed form (on green basketweave safety paper) and
retrieved from Hawaii—but this is not possible. All three versions
manifest itself as a printed document only when the PRINT button
is pressed from within the original manufactured document

file. This would account for the transformation of a document
containing different color backgrounds, and the ability to print
with or without safety paper pattern (by turning a layer on or off).

There is no doubt in my mind that this computer generated image
never started out as a paper source document and was never
scanned in as described by the White House—it was digitally
created and manufactured.

The bulk of this report will explain the evidence to support this,
which will include the following points:

= Inconsistencies within text characters: All anti-aliased text (in

Figure 1:  PDF file released from White House a color scan), or all bitmapped text (in a black & white scan)—
not a mixture of both which is impossible in a legitimate
_ document. Image noise should also be consistent throughout.
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Figure 4: Search for text is not recognized—No OCR applied
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Figure 6:  Font Properties dialog after OCR Text Recognition
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OCR—which stands for Optical Character Recognition—will scan a
document for text and convert any images of text to live (editable)
text.

After OCR is applied to a PDF in Adobe Acrobat Pro, the text
responds as if it is in a Word document. The OCR text can be
selected, changed, copied and pasted. The Obama PDF document
as downloaded cannot be edited in the aforementioned manner.
Note: Adobe Acrobat Pro has PDF editing functions, but Adobe
Acrobat Reader does not.

Additionally, if the PDF had been scanned using OCR software; one
would be able to search the document with keywords and if the
text exists in the document, then those keywords would be found.

Figure 4 shows the keyword “Live” typed in the FIND box, and even
though the word “Live” exists in the Certificate of Live Birth title, a
dialog box responds that “no matches were found.”

When viewing the font properties dialog box in Figure 5, no fonts
are listed. If OCR was used, the image area would be converted to
recognized fonts in the document and the fonts would be listed.
The dialog box is empty, indicating that Obama’s PDF file does
not recognize any text. This dialog box can be viewed by going

to the File menu > Properties, then click on the Font tab in the
Document Properties dialog box.

Font-based text can be created after a file has been processed
through the OCR Text Recognition feature in Adobe Acrobat. To
run the OCR feature, go to the Document menu and select OCR
Text Recognition, and then click Recognize Text Using OCR.
Acrobat will then perform a scan on the document and convert any
fext found in the image to editable text. Note that applying OCR
Text Recognition will alter the appearance of the characters in the
conversion from image to text.

Figure 6 shows that all the fonts recognized during the process are
now listed in the Font Properties dialog box.

Figure 7 shows another search (after OCR is applied) on the
keyword “Live” typed in the FIND box. The word “Live”is found and
highlighted within the Certificate of Live Birth title.
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‘ Noise, Anti-aliasing, and Bitmap

Noise v No Noise

Scanned images will have a consistent noise. Any inconsistencies
in noise would be a strong telltale sign of tampering. When looking
at an image at a normal zoom level (100%) colors may appear as
one color of any particular area of an image. Zooming in closer to
the area, consistent noise is easily apparent in the slight variations
of color from neighboring pixels that make up each color (shown
in Figure 8). This is the natural noise level for this image. Note that
it is consistent throughout the image; variations can be seen for
neighboring pixels of each color area in the original image.

In contrast, Figure 8 also shows an example of no noise as a result
of digital manipulation. Two pixels were sampled to match colors
e - within the image. Using a paint brush tool in Adobe Photoshop,
Figure 8 Painted brush strokes in digital scan lack noise a streak of each sampled color is drawn across the image area.

a] i ased Clearly the lack of noise in the digital brush strokes is inconsistent
with natural noise of the image. Components added digitally to an

b [tm 3 p imgge do not.contain noise. All neighboring pixels for thg sample
paint strokes in Figure 8 are solid in color with no variation—not
even the slightest of variations. In order to avoid detection when
editing an image, an experienced professional will need to mimic
the noise to match the document. One common method used is to
access the Add Noise filter found on the Photoshop Filter menu.
This was not done in the Obama PDF file. If this was a legitimate
color scan, noise would be consistently displayed throughout the
entire document.

Bitmap (or Aliasing) v Anti-aliasing

an tl -a I lase d Figure 9 offers a visual explanation of aliasing (or bitmap text)
contrasted with anti-aliasing. Notice that aliasing is the visual
stair-stepping of edges that occurs in an image which yields a
jagged edge. Anti-aliasing is the smoothing of jagged edges

in digital images by averaging the colors of the pixels at the
boundary edges.

Also notice the transition of pixel colors that occur in Figure 8
where contrast colors bump up next to each other. This color
Figure 9:  Aliasing (or bitmap) and anti-aliasing transition (averaging of color pixels) makes the lines appear
smooth when viewed at a normal viewing level. Without
anti-aliasing to soften this line edge transition of colors, images will
; have a choppy jagged edge quality (aliasing or bitmapped quality).
' Anti-aliasing is either applied globally (to an entire image) during
scanning—or not at all.

Figure 10 is a perfect example of an inconsistency that occurs with
image manipulation. The numerical characters 064 seen in the
Figure are all aliased or bitmapped, and the 1 is anti-aliased as
well as containing noise.

A color scan would produce anti-aliased results universally. While
it is possible to use a bitmap setting when scanning, the results
would create a black and white image—no color present. A bitmap
setting would turn every pixel to on or off—white or black. Soif a
|| bitmap setting was used in a scan, then there shouldn’t be a color
o N ' E background, along with varying colors in the text outside the

===== grayscale range? All text color values have green tone values—not

Figure 10: Bitmap edges are jagged v smooth anti-aliased edge black or grayscale.

[ Bitmap edges are jagged ] [_7\nti-aliased edges are smooth J
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Scanner Chromatic Aberration

What is chromatic aberration? This occurs when different
wavelengths of light are refracted differently as it goes through

a lens or prism during the scanning process. Light is refracted
differently as the scanner encounters one side of a contrasting
color (particularly with text) compared to the opposite side of the
contrasting color.

In simpler terms, Figure 11 is an example of Chromatic Aberration
in which the scanner produced warm red-ish color values at

the bottom and left edges of the text, and similarly the scanner
produced cool blue-ish color values around the top and right
edges of text transitions. Chromatic Aberration can be seen ata
high zoom level in color scans such as the AP version of Obama’s
BC—but this chromatic aberration is NOT present in Obama'’s PDF
released by the White House.

Because the AP version displays chromatic aberration, this is an
indicator that the AP did receive a printed hard copy of the BC from
the White House and scanned whatever was presented to them. AP
did not do anything wrong. They simply scanned what was handed
to them.

It’s important to note that the AP version does NOT have a
basketweave safety paper background pattern, but rather a baby
blue colored background. This sudden difference in background
color/pattern is another inconsistency that could NOT happen if
the document was simply scanned with no further manipulation
and released by the White House—but this inconsistency would
only happen if the White House document is a manufactured file.

Applying the Terms Reviewed

A key problem with the document, as presented, is that it is riddled
with inconsistencies. Scanning a document without manipulation
produces an image with qualities that are consistent globally
(throughout the entire image). Amateurish image manipulation
will reveal local (specific areas) of inconsistencies or odd artifacts.

Another example of anti-aliased text containing noise for the letter
“R" mixed with surrounding bitmap text in Figure 12. The white
halo effect surrounding the text with no chromatic aberration is
also a strong indicator that the document was manipulated (more
on the white halo later).

Figure 13 displays text color inconsistencies in dates, along with a
misspelling in the official stamp text—"TXE" instead of "THE While
it may be argued that the misspelling is merely a function of the
stamp ink applied unevenly, the odds significantly decrease that
this would occur on both vertical bars that affect both sides of the
“H" character. Both sides pull in substantially displaying an“X."The
stamp also sports suspicious markings in the "Alvin” signature that
has been referred to as a “happy face”

Figure 14 offers a contrast image of Alvin Onaka’s stamp in which
the words are spelled correctly and no "happy face” markings in
the "Alvin” signature. The “Ph” spacing between the"P” and “h" is
different in both signature images (the period spacing as well).

Also, the stamp version displayed in Figure 13 is a solid bitmap
layer—no signs of texture (ink stamp on paper) can be detected.
Some semblance of texture wouid be reflected in an image

scan (even with optimization applied), but this overall quality of
texture—the ink stamp on paper as seen in Figure 14—is absent
from the Obama PDF.
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Attempts to suggest optimization explains the presence of layers in
the Obama PDF is simply not true. While it is true that optimization
can cause layers, it is not true that optimization explains the layers
displayed in Obama’s PDF. The layers in Obama's PDF clearly display
a decision-making process that would be present with image
manipulation.

Layer 1 includes the following sub-layers:
‘é"{‘ 10611

T o | g o oo
- s cum, 0 T
LRuEE T T 4

Outsnde border edge boundary path

i I On?gg%gn;gikgéi;g -1;;J

CERTHICATE OF LIVE SITH =
a4 151
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A simple definition for optimization is a process that applies
—— suitable compression settings to reduce file size.

As stated—optimization can cause layers—but in the case

ERPTY OneLmk

o Tt

( One flat image )\.l =

&% 35,700

of optimization; the process of how the document is layered
is completely computer-generated based on programming
algorithms. Thus, there are certain predictable patterns.

Before examining the Figures, it might help to explain that there are
two types of graphic programs: Raster-based and Vector-based.

Qdana T r\,, AT hID
et Y

Raster-based is a fancy word for pixel-based which is the strength

of a program like Adobe Photoshop. Whereas Adobe lllustrator

is a vector-based program—meaning it relies on mathematical
interpretations. lllustrator operates differently than Photoshop in
that lines or shapes drawn in lllustrator are referred to as paths—the
mathematical equations that define the line, line segment, or shape.
With this in mind, when a pixel-based image is opened in lliustrator,
a path is generated to define the outer boundary border of that
object. This is why you will see sub-layers in the screen capture
Figures with a Path title that corresponds to the visible blue (default
color) rectangle-shaped border edges of an abject (in the displayed
image).

The AP file version of Obama’s PDF in Figure 15 will serve to
represent a scanned document and when opened in lllustrator,
there is only one link, and one layer; the layer breaks down to
display the following sub-layers:

A boundary edge Path—the biue border surrounding the image

Figure 15: Normal one-layer scan document behavior

T e 1 o - E

Outside border path
Clipping Path q

And the flattened Image

Figure 16 shows a crucial difference in the number of layers
displayed in Obama’s PDF file (compared to the AP file): Obama’s
PDF has nine links and nine sub-layers (NOTE: The paths are actively
displayed in the image). In addition to the nine sub-layer objects,

a clipping path is at the top of the sub-layer list. The clipping path
groups all the remaining sub-layers below. Note the location of the
clipping path in the image, which will be explained further on the

= next page. It's presence within the file and applied in a manner to

A hide portions of the image also reflects image manipulation.

Figure 16: Multiple layers and links in Obama’s PDF
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No logic to layer
object decisions

Another crucial difference in the number of layers occurs when
optimization is applied to the AP scanned image in Figure 17.
There is an unreasonable amount of layers generated. Note despite
resizing the Links and Layers panels, there is still a scrolf box which
scrolls the length of the empty scrolling bar area (to offer a sense of
how many layers extend beyond the current view).

PESoTINETTTINY

sesgdorveCeeye

Examine how the layers divide the image into pieces. It is analogous
to taking a scissor and cutting the image into random rectangles.

<t~ Huge amount of links | i
| Insane number of color sub-layers I—P
T

Finally, notice that Figure 17 calls out the top layer as a bitmap layer
(which means it contains one color value only), while all remaining
layers are color layers (contains multiple color values). One bitmap
layer and multiple color layers are typical optimization behavior;
but the reverse is true in Obama’s PDF in which it contains multiple
bitmap layers and only one color layer.

Figure 17

AP layers and links after optimization is applied
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Let’s return to the previously mentioned Clipping Mask Path. The
term mask refers to defining parts of an image to be hidden from
view (rather than have to delete unwanted parts). Any vector shape
can be used as a clipping path—in this case the rectangle path
shape seen in Figure 18 defines an area that acts like a window;
Anything within the shape border is visible, and anything that falls
outside its boundary is not visible. A benefit derived from using a
clipping mask is it allows the mask to be reposition at any time to
show or hide different parts of the artwork. A clipping mask that
hides image information from view only occurs in a manual process
to manipulated a document. If a clipping mask is generated in an
optimized file—it will never hide information.

Figure 18 displays the clipping mask as the only visible path
when the Obama PDF is first opened—all other path objects
behave as a group attached to the clipping path. To move and see
these objects separately—the clipping mask group needs to be
released—or ungrouped.

Figure 19 shows an open Layers panel (to display the sub-layers).
A right-click inside the clipping mask offers a menu option to
Release Clipping Mask. Notice that releasing this path not only
exposes the other grouped path objects, but suddenly uncovers
additional background pattern that spills outside (and beyond) the
clipping mask path boundary—proof of image manipulation.

Tom Harrison, a software designer, published a report that
examines the top two sub-layer objects. Without a doubt, the
implications of these two sub-layers are clear indications of image
manipulation. This cannot happen in a normal document. At first
glance these layers appear to be empty—but this is not the case.
These layers contain odd random white pixel information, while
the pixels under the white dots show no disturbance of safety
paper pattern (on the bottom layer). This is simply not possible in a
normal scan and can only happen in image manipulation.

Tom Harrison offers the following analogy in his report: Try to have
someone take a picture of a person holding a football hidden
behind their back, not visible to the camera. Will you ever be able
to extract the person from the photograph and still see the football
revealed? Of course not. However, if a picture is taken of a football,
and a separate picture is taken of the person, layers can be used

to "hide” the picture of the football behind the person (using a
program like Photoshop). By placing the picture of a person on a
layer “in front of "—or on top—of the layer containing the football
in the document—the football would not be visible to the casual
viewer unless the layer of the person is turned off.

Using the football analogy, look closely at Figure 20—a close-up
view to reveal numerous white pixels in the top layer object.
Additionally, these pixels are bitmapped rather than displaying a
soft blending quality to transition into the background pattern—
another indication that the white pixels are not a normal part of
the background pattern.

Figure 21 shows the white dot layer turned off to expose the
undisturbed safety pattern in the background {under the white
pixel dots). To paraphrase Mr. Harrison, no scanner in the world
has x-ray vision that can detect uninterrupted safety paper pattern
under another object (such as the random white dots).
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The main purpose and strength of layers is they allow parts

of an image to be isolated to make it easy to repositioned, or
adjust visibility {on or off) independently of surrounding image
layered parts—thus layers are a powerful image manipulation
tool. It makes sense to have a date and a certification stamp on
separate layers—to move, rotate, or reposition for the purpose

of manipulation and alteration. Figures 22-24 demonstrate how
objects can be moved around independently. The Obama PDF
has a clean separation of text isolated on each layer, unlike the AP
optimization layer results for the same information in Figures 25-
26.The layer results seen in the Obama PDF cannot be duplicated
through optimization, but can be easily duplicated (and explained)
with an understanding of image manipulation.

The date stamp and certification stamp are the selected layers in
Figure 22.The Links and Layers panels verify the selection along
with the active blue paths that display around the layered objects.

Figure 23 demonstrates that the objects can be moved
independent of the background (or other text items). Note that in
the Obama PDF, the text for the certification stamp is completely
and independently separated onto its own layer. The same is true
of the date stamp. This is a clear and important indication of image
manipulation in which each of these items can be manipulated
independently of the surrounding background layer. This clean
separation can only be accomplished through image manipulation
of document elements.

Figure 24 shows the background layer can also be selected and
moved independently from the stamp and date layer elements.
The white halos are a part of the background layer since white is
the typical color present when building a background layer. Thus,
whenever the safety paper pattern is not present, the typical color
displayed in the absence of pattern will be white.

Automation v Manual Manipulation

Figure 25 and Figure 26 shows the lack of predictability when

an automation process chops up an image and generates layers
during optimization. As previously mentioned, the AP file opens
with the appearance of a normal scanned document containing
only one layer. For this reason, the AP file was used to demonstrate
what happens when optimization is applied. After the optimization
process, the AP file displays a multitude of layers.

Most of the black text extracts onto one bitmap layer at the top of
the layer list. This top text layer is turned off in Figure 25. Note that
the text does not separate cleanly onto one layer. Remnants of text
remain behind on a variety of the many multi-color layers in the list
that still have their visibility turned on in Figure 25. Additionally,
the top text layer contains a large portion of all document text and
optimization fails to separate text according to usefulness. In other
words, all the stamp text does not reside on its own layer—nor is
there a different layer for the date text—and again, no clean and
complete separation.

Figure 26 has the top text layer visibility turned back on again,
but instead, one of the bottom background layer’s visibility is
turned off this time. The selected paths show how there’s no
human quality to the logic in dividing information into layers—the
machine is deciding based on an automated process.
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White Halo Creation

The white halo effect presents two common questions; why is
there a white halo, and what caused it? Before answering the
former question, let’s address the latter.

The white halo could simply be a function of a selection created
around all the text—before filling the background layer with a
green safety pattern.

The green safety pattern could have easily been applied to the
background layer without any selection—thus a solid pattern
would have covered the entire background layer—without a white
halo. But for some reason, a white halo effect was generated—
either through an active selection when creating the background,
or through an enhancement process, or a combination of both.

As might be expected, the creation of a background using a text
selection is easily demonstrated with step-by-step Figures.

Figure 27 shows the demonstration file set-up. The stamp text
from the Obama PDF file was copied (from lilustrator) and pasted
into a new Photoshop file on a layer that is above a solid white
background layer. Note the two layers in the Layers panel: Stamp
Text layer and the Background layer (currently filled with white).

When working in a graphic program, if you want to apply any
changes to an image, you have a choice to use a selection for the
target area, or to make changes without a selection. If there is no
selection, then any changes can be applied to the entire image
without any restrictions. If a selection is created, the changes are
limited to the selection area only. Analogous to selecting text in

a Word program to apply a change, such as bold formatting; the
text is first selected, and the bold formatting is then applied to the
selection only.

In this example, a selection will be created around the text as the
next step shown in Figure 28. Any object separated on a layer
can easily be used to create a selection of that object. Simply hold
down the Ctrl key and click on the layer thumbnail—in this case
click on the Stamp Text layer. A selection that resembles marching
ants appears around the text. The next step is to expand the
selection to include a little extra space surrounding the text. This
can be accomplished from the Select menu, using Medify, and
then choosing the Expand option (also seen in Figure 28).

The Expand Selection dialog box displays in Figure 29 which allows
a user to specify how many pixels to expand the selection. Since,
the idea is to surround the text by a small area, the amount entered
in this example will be 2 pixels.

The expanded selection in Figure 30 currently surrounds the

text. However, the current selection area needs to remain white
since the ultimate goal is to apply a pattern fill to the surrounding
background area—not the surrounding text area. Therefore, the
selection needs to be reversed—also known as inverse—to ensure
the pattern will fill everything on the background layer except the
text area.

Go to the Select menu shown in Figure 30. The Inverse option is
chosen. The selection is now ready to fill with a color, or a pattern,
or even another scanned image (such as a scan of basketweave
safety paper). Everything but the text area is now selected. For
purposes of this demonstration, the next step will define a safety
paper pattern and fill the background layer using the current active
selection.
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Safety Paper Creation

In a program such as Photoshop, a selection can be filled with a
solid color of choice, an image, or a pattern can also be defined as a
fill option. It should be noted that a full sheet of safety paper could
have been scanned and used without going through steps to define
it as a pattern—but a pattern can be easily defined from an existing
image as an alternative method. Most likely, there was access to

a sample of safety paper when creating the Obama PDF. It's not
necessary to reinvent the wheel—the current Obama PDF file will be
used as the source pattern for the purpose of this demonstration.

The Obama PDF is temporarily opened in Figure 31 and a square
selection is made to isolate a portion of the pattern that will tile
easily—which means that when the selected area is filled repeatedly
next to each other, the pattern continues seamlessly—without any
noticeable disruptions in the pattern. With the selection active, the
Define Pattern option is selected from the Edit menu. The Obama
PDF file is closed and no longer needed.

Back to the demonstration file shown in Figure 32; with the
Background selected as the active layer, the Fill option is chosen
from the Edit menu.

In the Fill dialog box, the Pattern option from the Content list is
chosen in Figure 33.

The safety paper pattern defined earlier in Figure 31 is also chosen in
the Fill dialog box in Figure 34. Click OK to complete the effect.

The results in Figure 35 show a slight white halo outside the text.

In Figure 36—the Stamp Text layer’s visibility is turned off, and the
marching ants are deselected (Ctrl+D). The white halo effect was
easily manufactured in less than a minute, in less time than it took to
read the explanation.

In summation, the safety paper background layer was added as

the last step to create the illusion of an image in which text was
imprinted on basketweave safety paper. However, the text had in
fact been placed and arranged on a solid white background. This
last application gives a created image the false appearance of being
an official document.

sHRNAAANN

Fa
&
o
.
&
b
®
a
|
*

FOERTIEY THIS.IS A TRUE GOPY OR
RACT OF THE RECORD ONFILE R
xwm STATE BEFARTMENT OF HEALTH

Background
contains pattern fill

Figure 35: The pattern fills the selection area

ST L0

[ stamp Text visibility off |

e

I S BN

=}

White halo effect

Figure 36:  Turn off the text layer: White halo effect is displayed




REPORT BARACK OBAMA: LONG FORM BIRTH CERTIFICATE

F’-’ STATR QT ANl CERTIFICATE OF LIVE BIRTH RECART AT oL HEALEY
- FILE 15] 61 10811
NUMBIR
—T1n Chtd's First Name  (Type or prind) 16, Middic Name le. Lan Neeie
BARACK HUSSBIN OBAMA, 1T
I Fex 3. This Binh 3. i Twein or ;-npm s. Fonth Doy Year ‘&Sh. Yeur 7
{ 24
Male -.I.ES Tuin (] 'mpi.-lj 1alf] 2003 3wal]] Do August 4, 1961 24 Py,

& Plaze of Birthy City, Town or Rursl Location Gh.  Island
B Honolulu Gehu

-

¥

e Toul Heskdenes ol Wothrs Gity, Tows or Rural Locairle I 5. Tlend

seic of Harpital or Truifunion (11 nal in hoapital ar fsilsntian, give vireds nddress) |6

Kapiolani Maternity & Gymecolfgical Hospital

ar Town Llmlis
1 ng .m St et
Y1 e

e Taunly snd Susia or Forelgn Commiry

Honolulu Oshu Homolulu, Hawaii.

74 Sirerl Addreny T7e. T Mewidaner Tnide City of Town Limite?

6085 Kalanianaol{” .vm Judleial disrrict
(7 Blailer's Mailing Addrers Forgot to turn off a g T ey g
short form layer o
& Fall Name of Father 9. Hece of Father
BARACK HUSS! Africsn

10, Age of Fotber |11 Birihplace (Iwd, Sui <t Toreig Comnrr)|1 25, Usual Qesupatien T35, Kind of Bunntse or Indoitty

25 enya, Bast Africa - : Student i University
13, Full Mziden Name of Mother 14, Race of Mother

STANLEY ANN DYNHAM Caucesian

5 Ags of mmri 16, Birihplsce (iad, fure o Fereign Cownn] 178, Type of Occupation Ouwid) Wome During Tregawnsy [175.  Dewe Tant Wortad

18 h’ichit.a, hanaas None

Fig

Fig

Nlrucl
el

I eertify shat the wbove statedt |!He ), iure of Parcl) or Other Informant AIT8E. Dae of Sgmature

wum-bn:n:l. rue md correet |fy (s Poret LR
1 perehy oty s b i i 05, Oata € Signature
o ges

kte Atzepied Generat
Y T

Forgot to turn off safety-paper Background color
layer in manufactured shadow magically shifts to blue

FCERTIFY THIS IS A TRUE COPY OR
AUSTRACT OF THE RECORD ON FILE ft
THE HAWAN STATE DEPARTMENT OF HEALT..

DRt T Onatn O b,

STATE REGISTRAR

APR 25,2001

ure 37: Some extra remnants visible in the AP version

Enhancement appliedto [y
display short form elements

ure 38:  Enhancement applied to easily see short form

Page 10 of 10

Some Final Thoughts

The previous exercise demonstrated how the white halo could be
created, but there can be a multitude of ways to accomplish the
same task in a program such as Photoshop. Whether or not the
exercise presented is the definitive method is not the main point.

The exercise was presented as a possible solution to the question:
How did the white halo get into the document? But actually, the only
question that matters is: why is the white halo there at all? Any
official document obtained by legitimate procedures and scanned
would not have the white halo.

As previously stated, every anomaly can be easily explained as a
manufactured document. Not only does this document display
attributes that it was completely manufactured digitally, but there
is strong evidence that a master file exists as a source file. What is
meant by a master file? A master file is a file in which all the objects
still exist on separate layers (in other words, more layers and
information than seen in the Obama PDF sub-iayers).

For example, in the Obama PDF, the bottom layer contains the
background pattern with some text elements merged onto

that layer. In the master file version, the text still remains on a
separate layer—NOT merged with the background layer. It is
highly probable that this master file also contains the short form
certificate layers (which would explain the problems seen in the AP
version of the fiie).

Figure 37 and Figure 38 demonstrate that the AP version of the
long form certificate contains a different set of problems as follows:

= Asudden shift to a different background

= Safety paper pattern in the shadow at the left edge—but not in
the document background

= Short form embedded into the printout—Figure 38 is an
enhanced version which allows the details to be seen more
easily

Once again, all of these additional problems displayed in the

AP version would not occur if the source document presented

to the AP had been a legitimate scanned document without
manipulation. However, all three problems would easily be a result
of a manufactured source file—in which layers from a master file
were turned off or mistakenly left on.
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